“FI“
Electronic Fuel Injection System

Instruction Manual
“Introduction”

Thank you very much for purchasing the “Fi” system. “Fi” is a fuel injection system for small displacement motorcycle, and this system is not a simplified but a full functional system, as well as it of large displacement Motorcycle. ECU(Electronic Control Unit) can detect various states of engine by various sensors and control the optimal volume of fuel. Furthermore, if you use this system, it is possible to set up almost all the parameters about Injection with the personal computer linked to ECU. Almost all parameters can be set up by the full range. Of course, you can use a setup which FC design prepares and can also do a setup from zero.

Please read notes of the following page before beginning to use this system.

If you have any questions about this system or instruction manual, please contuct us.

FC Design
2-1-48-101, Honmachi, Fuchucho, Akigun,
Hiroshima, Japan post code 735-0006
Tel +81-82-287-0211
Fax +81-82-287-0212
http://www.fc-design.com
E-mail:info@fc-design.com
“Attention”

(1) This product is only for racing use. Therefore, we recommend strongly that you use this system in safe places which can respond to the emergency engine stole by the mistaken arrangement etc., such as a circuit.

(2) Please install controller in the place which avoided raindrops, splash, etc.

(3) Do not install a controller in places which become high temperature extremely, such as near an exhaust pipe.

(4) When you arrange setting or check this system with engine started, we recommend you to go in a well ventilated place strongly.

(5) Since high pressure has started the fuel line, please check pipe and hose to keep a performance and safety. Moreover, please be sure to check before a running.

(6) In order to avoid the accident, please decompress the pressure in fuel line before decompose a fuel pipe system.

(7) Do not use this product other than the original purpose.

(8) You shall not about this system (Hardware, Software, Documents, etc.):
   (a) Copy, in whole or in part.
   (b) Modify
   (c) Reverse engineering of the composition parts of this product containing software.
       (Reverse compile or reverse assemble the PC software and ECU firmwear)
   (d) Transfer software, a document, and CD-ROM independently.

(9) When you use this system combining the products of the other company, we do not take responsibility for other company’s products.

(10) If you have troubles and accidents by using this product without observing notes above, we will not take no compensation and responsibility.

(11) We do not guarantee the following matters. Please acknowledge it.
   (i) Problem of “setting software” by installing other software.
   (ii) Problem of other software by installing “setting software”.

---

**Warning**

**For Racing Use Only**

**Danger**

- fuel pressure over 4kg/cm²
- Fire strict prohibition in disassembly

**Caution**

- avoid exposure to water
- avoid static electricity and electric shock
“When you connect ECU to the system harness...”

(1) After removing terminal of vehicle wiring which are connected to the battery, connect system harness to wiring of vehicles, attach or remove ECU to system harness.

(2) When ECU is connected for the first time, please look at the lamp display of ECU well. Please turn off a switch promptly, and check the polarity of a power supply, and connection, when a power supply lamp does not light up.

(3) When you disconnect a coupler from system harness, be careful not to cut the wire of it.
“Content“

(1) Product outline

(a) ECU exterior. p1-1
(b) Fuel Injection Control. p1-3
(c) Other Controls. p1-7
(d) Other Parts of System. p1-8
(e) Dial Controller. p1-10
(f) Lamp Display Function. p1-12

(S) Getting Started

(A) Hardwear installation A-01
(a) Layout A-02
(b) Guidance of wire harness connection. A-09
(c) Installation of fuel piping. A-11
(d) Execute the air pulling out of the fuel piping. A-13
(e) When air enters while operating and pressure doesn't go up.

(2) Tutorial of PC software [ SWB ] p2-1

(a) How to Install. p2-5
(b) Outline of “SWB”. p2-6
(c) Start and Exit. p2-7
(d) How to Set-up the Settings. -- “Map” p2-9
(e) Read Settings from ECU. p2-10
(f) Read Settings from the File.
(f') To change the maximum value of R.P.M. display.
(g) Save Settings to the File. p2-11
(h) Edit “Basic Injection Time” Settings. p2-12
   (A) “Changing a value for every point” p2-14
   (B) “Multiplying “Gain” p2-18
   (C) “Changing a value for every point” p2-19
(i) Change Enable/Disable of Each Compensation p2-21
(j) Edit “Pump Control” Setting
(k) Edit "Revolution Speed Limitter " p2-22 & " Indicator "Setting p2-26
(l) Edit “Compensation Table” Settings p2-27
(m) Transmit Settings to ECU
(n) Data Monitoring Window
(n’) Show A/F data on Data Monitoring Window
(3) Configure and sensor adjustment.

(a) Setting of close values and full open value of throttle sensor.
(b) Setting of the Idle throttle threshold.
(c) Adjustment by capacity of injector and displacement of engine.

Export & Import function (About the copy of the map between two ECU)

(B) Appendix

Specifications of ECU

Wiring diagram (alpha-N, Throttle-Speed type)

Wiring Diagram (D-Jetro ~ Speed Density / alpha-N + Boost Sensor)

Connector Diagram

Windows(R) is the trade mark of Microsoft corporation.
(1) “Product Outline”

(a) ECU exterior

Photo. “Fi” system ECU (Electronic Control Unit)

ECU8P, ECU10P: In case a coupler is connected, a main part is pushed in by hand until sound “Click”. When disconnecting, couplers are pulled, after pushing in the button of the coupler upper part.

Be careful not to cut the wire of it.

A communication cable connects only the cases at the time of an setting arrangement etc. with PC serial port by the cable contained in this products. In addition, it can attach also in the state of power supply ON, or can remove.
Photo: **ECU has two display lamps.**

- **Green**: Power Supply Indicator Lamp
- **Red**: Information Indicator Lamp (Same Function as Dial Controller Lamp)

The lamp on the right-hand side of a photograph is a lamp of the red which performs a system information display. It is the display of an injection timing signal input, a system error, etc. Display function is almost same as dial controller lamp. (except a shift-up indicator function)

*Please read Chapter (f) “Lamp Display Function” for details.*

The lamp on the left-hand side of a photograph is red lamp, ECU power supply indicator, when the power supply is on.

When IG key-off, ECU power OFF is postponed only for between the change check of arrangement data. In this period an ECU power are supplied from “Backup” wire of system harness which is connected to battery plus terminal. After that, ECU is turned off and holding data does not need power supply.
(b) Fuel Injection Control

The volume of fuel is controlled in time of ON period of injector.

\[ \text{Volume}(cc) = \frac{\text{Injector flow rate}(cc/min)}{60 \text{ (sec)}} \times \text{Injector ON period (sec)} \]

By the text after this, time of ON period of injector is called injection time. You can set injection time to 32msec at the maximum in each cycle. Injection time is calculated as follows.

Injection time \( (Ti) \)

\[ = \text{Basic Time}(Td) \times \text{Startup Compensation} \times \text{Warm-up Compensation} \times \text{*Acceleration Compensation} \]

\[ + \text{Injector Opening}(reaction) \text{ time} \]

*Speed-Density System Only (*D-Jetronic version)

You can set these compensation values to “1.0” quickly with each enable/disable property on software. The lower figure expresses control of injection.

The outline of each control is explained in the following page.

**“D-Jetronic” is the registered trademark of Bosh AG**
[ About Basic Control Method ]

In standard "Alpha-N" version, ECU controls a injection time according to the intake air volume estimated with two parameters, "the open angle of throttle" and "engine speed". In the version of "alpha-N", the response of the engine is better than other versions. However, the control of this version needs the adjustment of the map when there are a secular distortion and a condition change, compared with the control of the type that measures the amount of air directly. We also have ECU that controls the following types.

* D-Jetronic (Speed Density Type, normal, turbo)
* Alpha-N with Boost Compensation

![Injection Time (WOT) [sec] =
air charging efficiency [%]/100 * engine displacement [cc] * air density
/ AF ratio / fuel density / (injector capacity [cc/min] / 60)]

As larger the throttle boa, the change becomes steep in the area of opening of the throttle from idle. (And depending on the volume of the Intake manifold after throttle.)

In the high speed area, charging efficiency rises in the engine that uses a high-speed cam.

The horizontal part is necessary for the idle control.

When becoming over 16000 rpm, ECU controls a Injection time by the parameter of 16000 rpm.
"Basic Injection Time"

**Throttle - Speed Control Version (Alpha-N)**

There is a map of injection time to the volume of intake air determined with two parameters, the open angle of throttle and engine speed, in ECU, and the "basic injection time" is determined with reference to the map. Even when the open angle of throttle and engine rotation speed take the value between axes, the injection time is computed by complement calculation.

An injection map can be edited from PC.

The axis of a map can be set up to 31 at the maximum to each of the open angle of throttle, and engine rotation speed. It is possible to set up arbitrary number of the axis to the arbitrary axis value in this range.

![Injection Time Map](image)

**Speed - Density Control Version ("D-Jetronic")**

There is a map of injection time to the volume of intake air determined with two parameters, intake manifold pressure and engine speed, in ECU, and the "basic injection time" is determined with reference to the map. Other control function is same as "Throttle-Speed Control".

This Control Method is best for super charged engine (turbo, etc.). In a super charged engine version, intake manifold pressure is detected to about 2 kg/cm² (1600mmHg). (Normal version sensor is up to 800mmHg.)

* Accelerate Compensation is only for "D-Jetronic".
  See Detail (Section)

"D-Jetronic" is the registered trademark of Bosh AG
“Compensation”

*Please read Chapter 2 for details.*

**Warm-up Compensation**
*(Engine Temperature Compensation)*

This is compensating the lack of fuel evaporation and increase in volume of air filled in engine when engine has got cold.

**Start up compensation**

This is compensation which increases fuel after starting of engine until it carries out stable rotation.

**Start up injection time**

This is not a compensation value. It is injection time which will be injected in a period until it becomes a rotation speed stable.

**Asynchronous injection time**

Asynchronous injection is the function to perform compensation injection, when change of the intake air volume rapidly between the timings of synchronous injection.

**Fuel Cut Control**

In engine rotation speed over idle speed, fuel injection is stopped at idle throttle position. This functions also as an idol R.P.M. limiter.

**Accelerate Compensation (for *D-Jetronic only)***

This function correct a gap of the air / fuel ratio resulting from change of the intake pressure by acceleration or slowdown. It differs from the asynchronous injection which performs compensation injection temporarily that the volume of synchronous injection is increased or decreased between a certain set-up cycles.

*“D-Jetronic” is the registered trademark of Bosh AG*
(c) Other Controls

“Pump Control”

The pressure of fuel is required for fuel injection. The in-line pump is controlled from ECU. To suppress the consumption of the battery, ECU intermittently drives the pump in a low rotational speed according to the amount of a necessary fuel. In a high rotational speed that the flowing quantity of the fuel increases, ECU drives the pump with PWM. It is possible to perform a setup of a drive from PC connected with ECU.

*ECU is not measuring the pressure of fuel. Please set up the parameter of ECU, looking at the pressure gauge attached to this product ("Fi System set") so that required pressure may be obtained.

“Revolution Speed Limitter”

Fuel injection will be stopped if it becomes more than the set-up rotation speed. You can set it as arbitrary values from PC.

“Shift-Up Indicator”

The lamp on the dial controller is turned on when it becomes more than set R.P.M. You can use it as a shift-up indicator.

*Option “Extended Injector control”

ECU also controls Extend Injector for Oxygen injection system (Option). Please read the description of an oxygen injection system for details.

Please read Chapter 2 for details.

“Internal Log Memory” (New Function of ECU 1.0.20.12)

ECU can record internal data of seven and a half minutes in the memory. You can download and view data with the "Fi Log Reader" software.

*Please see the "Fi LogReader" manual for details.
(d) Other Parts of System

“Throttle body”

It is the throttle of a rotary valve. Injector, the throttle sensor, and the extraction mouth of intake pressure are attached to this.

*) The photo is of the throttle of 32mm boa.

“Signal interface unit”

This is the unit which makes the signal for injection from an ignition signal. This makes 1 time of a signal to two rotations of a crank.
(For 4stroke engine.)

*) We have also the version of every clank injection.

“Temperature sensor”

The element for temperature detection is enclosed. It attaches in the cylinder side and the temperature of engine is detected.

“Dial Controller”

There are a dial which changes fuel injection time by one point temporarily, and a lamp which displays information in this. The chapter(e) explains for details.

“Fuel pump”

It is the in line pump for fuel driven on the voltage of 12V. The maximum output pressure is about 4 kgf/cm2. The rated pressure of a system is 2.2 to 2.5 kgf/cm2.
“Fuel pressure regulator“

It attaches in the fuel piping. This keeps the pressure of fuel constant.

2.2 to 2.5 kgf/cm²

“To absorb the pressure fluctuation of the pump“

The pressure of the fuel line has the change for an intermittent drive of the pump. It can be suppressed by the method of the figure below.

The effect of the damper is achieved when putting some air in the fuel piping immediately before the gauge of pressure. (closed line.)

“Pressure sensor“

This detects the pressure of intake manifold. This sensor is only for “D-Jetronic system”

Sensor of version for supercharged engine maximum : 1600mmHg (about 2kg/cm²)

Sensor of version for normal engine maximum : 800mmHg (about 1kg/cm²)
Log Function Switch

Log "Function ON/OFF" SW. turn SW to red mark for Log "ON"

Wire Harness MINI
2Pconnector for Log SW
Brown=SIG, Yellow=GND

Wire Harness MINI
3Pconnector for A/F Sensor
Analog Output
Light Purple=SIG, Yellow=GND
(e) Dial Controller

Photo: Dial Controller

“Function”

The “Dial Controller” is equipped with the dial which can increase or decrease injection time (whole map) temporarily, and the lamp which displays the information on ECU. It is possible to change injection time in the quite big range from 0.1 times to 1.9 times by the dial. A left rotation side is the direction of “rich” (upper scale 1-1.9 time), and a right rotation side is the direction of “lean” (lower scale 0.1-1 time). The minimum scale is 0.1.

In addition, since a setup of the range corresponding to a dial can be changed into arbitrary values from PC, adjustment width can be made large (for example, 0.05 time -4 time etc.), or it can be narrowed (for example, 0.5 times to 1.5 times etc.).

Please read Chapter (f) for “Lamp Display Function” details.
The example of use of a “Dial Controller”

Although, as for a dial controller, only a primitive setup of changing the whole can be performed, according to a way, it can use for the arrangement of a map quite conveniently. The following is an example of use of a dial.

(1) After attachment "Fi", when starting the engine for the first time, the engine can be started correcting a gap of the injection time of the original map with a dial. You put engine into operation, turning a dial and changing various injection time first. You look for a dial position so that engine may carry out stable rotation. After engine starts, you look for the position which engine strats misfire by turning a dial. Thereby, you can know the “Rich” side limit of the injection time, and the limit by the side of “Lean”. You read the scale of a position which turned to the “Rich” side a little from the middle of those dial positions. You can know that that is the best injection time near an idol. It is good for you to adjust the injection time of the idol area of a map with this value of a dial.

(2) It may be good to apply the multiple value which corrected an idol's injection time also to the whole map.

(3) It is very difficult to touch a dial during a running, so you turn a dial before running and you run at a certain degree of throttle. You run in the same dial position and read the dial position which becomes the largest power. And you correct the injection time of domain, which you check on the map.

(4) When decomposing a fuel piping system, it enables you to lower fuel pressure simply by continuing operating engine, with a pump suspended. At this time, it can lower to remarkable low pressure by consumption of fuel pressure with engine by turning a dial to a rich side with descent of fuel pressure.
**(f) Lamp Display Function**

The red display lamp of an ECU and the display lamp on “Dial Controller” display the following information.

1. **The display of an injection signal input**

   An injection pulse will be inputted into ECU if engine is rotated using a kick pedal or a cell motor. When not engine starting, ECU performs “ON” and “Off” an information lamp at every input of a signal. If engine starts, this display function will be ended. You can know whether the function of a signal unit is normal by this display.

2. **Shift-Up Indicator**

   (*Dial Controller lamp only)

   The light is switched on when it becomes more than the engine rotation speed set up by control software (SWB).

3. **Injector wiring disconnection warning**

   The light is switched on when wiring to injector is disconnected. A lighting pattern is as follows.

   ![Lighting Pattern 1](image1)

4. **Pump wiring disconnection warning**

   The light is switched on when wiring to a pump is disconnected. A lighting pattern is as follows. (*Note1*)

   ![Lighting Pattern 2](image2)

5. **Battery voltage warning**

   The light is switched on when the voltage of a battery becomes low too much. (*Note 1 and 2*) A lighting pattern is as follows.

   ![Lighting Pattern 3](image3)
(6) **Warning at 100% duty cycle**

The light is switched on when the injection time exceeds time while a crank rotates two times. That is, it means that only injection time as set up cannot be injected. Usually, although it is thought that such a thing does not happen, when this display comes out and engine is turning at "Lean", it means that the injection capacity of injector is insufficient. A lighting pattern is as follows.

```
0.2sec  ON
1.2sec  OFF
```

(7) **Setting map reading error warning**

ECU reads the map for control from a memory, when starting. This warning display is turned on when a map has an error. When this display comes out, a controller stops all control. When a warning display does not disappear even if it reboots ECU after transmitting the map saved at PC again, please contact us. A lighting pattern is as follows.

```
0.2sec  ON
1.2sec  OFF
```

---

*Note1 Warning - Voltage & Pump*

**Pump wiring disconnection warning** and **Battery voltage warning** are detected only when the drive mode of a pump is "Pulse Drive". They are not detected when the drive mode of a pump is a PWM drive. (However, they are detected at the time of starting of ECU.)

*Note2 Battery Voltage Warning*

Battery voltage warning is turned on when it's voltage becomes less than 12volts. Usually, since it is normal that the battery is maintaining more than 12volts, when such a display comes out, please charge the battery promptly. Since it is thought that the pump drive cycle is too short (too much driven) when this display comes out frequently, I ask you to improve a pump drive setup. In addition, even when this display comes out, injection control does not stop. When it should become low voltage during a run, the fuel volume of injection decreases by the fall of the pump pressure. In this case, it is possible to run by turning a dial controller to a rich side and compensating the insufficiency of the fuel volume of injection.
[ Getting Started ]

Thank you very much for purchasing “Fi” system full kit. The following texts explain a flow from attachment to starting the engine.

[ Attachment and adjustment of ECU ]

(1) ECU and wiring (harness) are attached in vehicles.
   *Please refer to "guidance of harness connection".
   *Please attach a power supply wire through a fuse.

(2) You turn on the ignition switch. If there is no problem in attachment of harness, ECU drives a pump by intermittence, and turn on lamp of a dial controller, when preparation is completed.

(3) If you give rotation to engine by the starter or the kick pedal, the signal for fuel injection will be generated by “Signal Interface Unit” from an ignition signal. When this signal is inputted into ECU, the lamp of a dial controller will repeat ON and OFF for every input. When a lamp does not light up, ignition is not carried out or ECU has not received the signal.

(4) If the check of a signal is completed, the throttle sensor of a throttle body will be adjusted, and an injection setup in ECU will be adjusted to injector capacity. Please install SettingWorkbench (SWB) in a personal computer and connect with ECU by the communication cable. Please start SWB and read an injection setup from ECU. (Please save a setup at a file before changing a setup. Then, you can redo from the beginning later.)

Your Throttle Body : Diameter _____ mm : injector capacity ________ cc/min *1

How to adjust a throttle sensor is explained in the chapter of "adjustment of the hardware at the time of attachment" in a manual.
If you received the throttle body from us at the same time, we already have set sensor range & injector capacity to the ECU.
The injector capacity is recorded in ECU. An injection setup needs to be adjusted, when the injector capacity of your throttle body differs from this, and when the engine displacement volume of the injection control map currently recorded differs from that of your vehicles. The whole injection map is multiplied by the numerical value which is calculated by the following formulas.

**Specification of your “ECU” map.**

<table>
<thead>
<tr>
<th>Injector Capacity cc/min *3</th>
<th>Spec Displacement cc *2</th>
</tr>
</thead>
</table>

Value A = Injector Capacity in “ECU” / Injector Capacity of Your Throttle Body

Value B = Your Engine Displacement / Displacement of “ECU” map spec.

Value (for multiply) = ValueA x Value B

How to multiply the whole injection map and the value is explained in the chapter of “Edit Basic Injection Time Settings” - “(B) Multiplying “Gain” to every domain” in a manual.

* It is convenient to use the import export function to change to the setting matched to the engine displacement and the capacity of the injector. (see section 3-5.)

**[Starting Engine]**

1. Let's start the engine. Please check that fuel pressure is the 2.5 kgf/cm² neighborhood and that the lamp has repeated lighting and putting out lights for every signal input.

2. Does your engine start?
   If Setting is “Rich” or “Lean”, Engine will not start easily. Please turn a dial of “Dial Controller” (to rich side or lean side) and re-challenge.
   * If air is contained into fuel piping, it will not start easily. Please remove the air in piping.

3. Please turn a dial to rich or lean at the time of “idle”. Air By Fuel Ratio is the 12 neighborhoods when engine rotation speed rises most. Please adjust an “idle” rotation speed by the idol screw of a throttle body(Air) and SWB(Fuel).

4. Here, it becomes the work which changes an injection setup according to your engine. If the engine spec of the map in ECU is close to that of your engine, an injection setup will be correct in general also at a running. Engine will become better and better if the injection map is set finely. The injection time at power comes out most is looked for to every rotation speed and Throttle degree domain by changing a dial value of “DialController”. This will become very easy if you use “air by fuel ratio meter”.

*It is convenient to use the import export function to change to the setting matched to the engine displacement and the capacity of the injector. (see section 3-5.)*
(A) "Hardware Installation"

(a) "Layout"

Figure below is one layout example.
*1 Please install the fuel hose in the fuel tank. Please return the return hose directly to the fuel tank to prevent an air bite of the fuel pump.

*2 Please connect it with wiring from which the power supply is supplied with main key ON.

*3 Please connect the backup power supply wiring with the wiring connected with the plus terminal of the battery. Please connect minus wiring with the frame earth or the minus terminal of the battery.

*4 Please connect wiring from the signal interface unit with the plus side terminal of the sparking coil.

*5 Please install the temperature sensor near the head of the engine.

*6 Installation of injector on throttle body or intake manifold.

*7 The fuel pump is driven like the pulse because of the power saving. The pressure fluctuation can be absorbed to the air collected in the hose in the *7 part.
(b) Guidance of wire harness connection.

Please decide the position where each unit is installed.

Please install each unit, and fix.

Please fix the harness to the vehicle by using the band etc.

The harness kit is designed so that ECU is installed at the center of the vehicle.
* Attention: Please remove the terminal from the battery before beginning installing.

* Attention: Please connect an orange, red wiring to the line after the fuse.

(4) +BATT power (after IG switch) wiring (orange) is connected with the wiring where the +batt power is supplied when the IG key switch is turned on. In the case of Honda Monkey,"IG" line is usually in the meter case (front light case).

In the Meter (front light) case.

Two connectors (for +BATT-IG and +BATT-backup) are in this kit. (use If you want.)

+BATT power (after IG switch) cable (orange)
(5) Please connect red wiring (red) with the line connected with the plus terminal of the battery.

(After off the key, this power supply is used for ECU only between a few seconds. Afterwards, this power supply is not used. ECU doesn't need an extra standby power requirement.)

(6) Please install the earth connection line (with round terminal) in the earth of the body (battery minus).

(7) Please confirm not be wrong the connection of the plus and the minus of wiring.

Connecting red wiring to the plus line of battery.

red wiring : +batt (back up power)
earth connection wiring (with round terminal)
(8) Please connect each unit to the wiring connector.

throttle sensor (3pins connector)

injector (2pins gray connector)

dial controller (6pins connector)

ECU connector (8pins and 10pins connector)

dial controller
Please connect each unit to the wiring connector.

Signal interface unit
(4pins connector with light-purple wiring)

Please connect female connector of light-purple wiring to the (+) terminal of ignition coil, and connect the vehicle wiring, connected with the coil (+) terminal originally, to the male connector of light-purple wiring.

In the case of HONDA MONKEY (current model), coil (+) terminal color is green.

*Please contact me when you want to use it with a beam type timing sensor. (eco-run vehicle etc.)

Fuel pump wiring

Please connect pink and white wiring to connector of fuel pump. Pink wiring is (+), white wiring is (-).

*If you don’t need that the fuel pump is not controlled by ECU, it is necessary to install the dummy resistance. (about 1kohm)
(8) Please connect each unit to the wiring connector.

As for the temperature sensor, a round terminal is attached to one side. Please fix it to the engine.

The connector is connected with white connector of two pins in wiring.
(8) Please connect each unit to the wiring connector.

When you start using Logger Function, please connect the switch and the wiring to the Fi system harness referring to figure below.

*Please see the "Fi LogReader" manual for details.

When you use GRID LX-2 AF sensor, please connect "Analog2 output" to 3P connector by using small black connector of the attachment for the product.

---

**Fi Main Harness**

- **Log Switch**
  - When you turn on (turn to the direction of red mark), logging starts.

- **2P connector for Log SW.**
  - brown = sig, yellow = GND

- **3P connector for AF analog.**
  - light purple = sig, yellow = GND

- **Temperature sensor connector**

- **Fi Main Harness**

---

- **Brown** : Analog2 output.
- **Green** : GND
- **Black** : Calibration wire.
- **Yellow** : Analog1 output.
- **Red** : 12V input (power) +
- **Blue** : Heater GND.

---

*Please connect green wire to both of Fi system harness and the battery (power) GND(-)."
(9) First of all, please confirm the connection of wiring (Especially, (+) and (-) connection of the power supply). Please turn on the power (IG) switch after confirming. When ECU starts normally, the pump is driven about ten times by the pulse, and dial controller’s LED turns on.

Please do initializing referring to (3) "configure and adjustment " chapter of the user’s manual.

*When you bought the throttle body from us at the same time, the adjustment of the throttle sensor and the setting of the capacity of the injector have already been done. If you have already informed “FC design” of the displacement of the engine, a rough adjustment of the injection map is done.

*Please refer to "Start-up manual" for the adjusted parameters.

D-jetronic ( speed density version )

Please connect boost ( manifold pressure ) sensor.
(c) Installation of fuel piping

Please execute the air pulling out of the fuel piping after installing the fuel piping. (Please refer to next section.)

Diagram of the fuel piping

Throttle Body / FUEL INJECTOR

PRESSURE REGULATOR

FUEL TANK

FUEL FILTER

“To absorb the pressure fluctuation of the pump”

The effect of the damper is achieved when putting some air in the fuel piping immediately before the gauge of pressure. (closed line)

fuel pump drive method: After IG switch is turned ON. The terminal of white wiring is contacted on the body earth, then the pump will turn.

Please install the fuel pump in a position that is lower than the tank.

*) It becomes easy for air and the vapor to enter the inside if the pump is installed in a position that is higher than the fuel tank outlet. In that case, the fuel cannot be pressurized.

In standard piping, please return “Return pipe” directly to the fuel tank not to put air or vapor in the fuel line and pump.

When it is difficult to return the tank "Return pipe" directly, please return it to the pipe at a position near the tank.
The atmospheric pressure (Normal) or intake manifold pressure. (for supercharged engine.)

**Example. The connection of the pump and regulator.**

Fuel Line Inlet

Outlet

Fuel Pump

Return to the filter inlet or fuel tank

Fuel Line Inlet

Fuel pressure regulator

Inlet

Note: Although there is few case (it will fall immediately when pressure goes up for a moment) fuel pressure does not go up, don’t worry about it. In this case, small dust entered in the pressure regulator and the seal can not work temporarily. In this case, by means of the above-mentioned fuel pump drive method is performed, almost all cases, flushing dust with fuel flow and the dust are trapped by the fuel filter.
(d) Execute the air pulling out of the fuel piping.

1) Please arrange the fuel pump at a position that is lower than the tank.
2) Please remove the fuel line from the injector.
3) Please catch the fuel that comes out from the line with vessel.
4) Please open the fuel cock.
5) Please operate the pump.
   Please drive the pump for one second every a few seconds.

* If you finish installing wire harness.
  After IG switch is turned ON, the terminal of white wiring is contacted on the body earth, then the pump will turn.

6) Please do the inlet up, and beat by the palm lightly.
7) The air that came off returns to the tank.
8) Please close the exit of the fuel when air in the line comes off.
9) The fuel pressure begins to go up when air in the fuel line to the pump inlet and inside of the pump comes off.
10) When the fuel pressure doesn't rise, air remains.
11) Please drive the fuel pump for a while when the pump begins to send the fuel with the exit of the fuel line opened. Please put out garbage the fuel line and in the fuel pump by this operation.
12) Please connect the fuel line with the injector, raise the fuel pressure, and confirm the operation of the regulator.

* Please test the method of next page when the air of the fuel line doesn’t come off easily.
1) Please arrange the fuel pump at a position that is lower than the tank.
2) Please remove the fuel line from the injector.
3) Please catch the fuel that comes out from the line with vessel.
4) Please open the fuel cock.
5) Please connect the hand pump such as vessel for the shampoo (photo: example) with the exit of the fuel line.
6) Please operate the fuel pump. (To help pulling air from fuel line exit.)
   Please drive the pump for one second every a few seconds.

* If you finish installing wire harness.
   After IG switch is turned ON, the terminal of white wiring is contacted on the body earth, then the pump will turn.

7) Please push the hand pump at the same time. Air is pulled out from the fuel line exit.
8) The fuel pressure begins to go up when air in the fuel line to the pump inlet and inside of the pump comes off.
9) When the fuel pressure doesn't rise, air remains.
10) Please drive the fuel pump for a while when the pump begins to send the fuel with the exit of the fuel line opened. Please put out garbage the fuel line and in the fuel pump by this operation.
11) Please connect the fuel line with the injector, raise the fuel pressure, and confirm the operation of the regulator.
(e) When air enters while operating and pressure doesn't go up.

After the air pulling out at the installation, air might enter the fuel line while the Fi system is working and the fuel pressure not rise. Please refer to the following hints so as not to put air in the fuel line.

(A) Please install the fuel pump (inlet) and fuel filter in a position that is lower than the tank.

(B) Please install the fuel line from the fuel tank to the inlet of the fuel pump as short as possible, and straight.

(C) Please set driving time of the pump long when the fuel pressure doesn't go up.

(D) Please return “Return pipe” directly to the fuel tank if it is possible.
(2) "Tutorial of PC software [ SWB ]"

The setting value of ECUs, such as basic injection time and a compensation value, is set up by the control software “Setting Workbench For Windows” (the text after this describes “SWB”) which operate with the personal computer (*Note1) of Windows (*Note2). Next, the outline of how to use this control software is explained.

*Note1 ) A serial port is required for the personal computer which uses SWB. When there is no serial port, we recommend you use of a USB serial conversion adapter.


(a) How to Install

Please double-click Setup.exe in the folder corresponding to each version of Windows. In Windows2000 and WindowsXP, please double-click Setting Workbench.msi. Please complete installation with reference to the message displayed on a screen.

The newest information about the combination of corresponding OS and setup file, and installation method are indicated on the label of a CD-ROM case. Please perform after a check.

*When you install, please be sure to end other applications.

Icon of “SWB”
(b) Outline of “SWB”

“SWB” mainly has the following functions.

1. **Edit “Basic Injection Time” Settings**  p2-11
   
   A setup of “basic injection time” is possible. It is possible to set the rotation speed axis and “throttle angle axis of the point which sets up “basic injection time”, as arbitrary values. It is possible to multiply the whole setting map or arbitrary domains by a constant value.
   
   *In D-Jetronic, throttle angle axis changes intake pressure axis.*

2. **Edit “Compensation Table” Settings**  p2-22
   
   The table of the following compensation coefficients can be edited.
   
   - Warm-up Compensation
   - Start up compensation
   - Accelerate Compensation (for *D-Jetronic only*)

3. **Change Enable/Disable of Each Compensation**  p2-18
   
   You can set these compensation values to “1.0” quickly with each enable/disable property.

4. **Edit “Start-up Injection Time” Setting**  p2-24
   
   Setting of this function is also edited in the same window as edit of a compensation table.

5. **Edit “Asynchronous Injection Time” Setting**  p2-24
   
   Setting of this function is also edited in the same window as edit of a compensation table. You can stop “Asynchronous Injecton” quickly with enable/disable property.

6. **Edit “Fuel Cut Control” Setting**  p2-24
   
   Setting of this function is also edited in the same window as edit of a compensation table.

7. **Edit “Revolution Speed Limitter ” Setting**  p2-21
   
   You can change R.P.M. value of revolution speed limitter.

8. **Edit “Shift-Up Indicator ( Information Lamp of Revolution Speed )”**  p2-21
   
   You can set the rotation speed which an indicator lamp turns on as arbitrary values.
(9) **Edit “Pump Control” Setting**  p2-19
    You can set up the pump control settings in “Pump Setting” window.

(10) **Change Enable / Disable of Dial Compensation of “Dial Controller”**  p2-18
    You can disable the fuel injection time compensation dial of a dial controller. When you use this product without connecting a “Dial Controller”, please set up “disable”.

(11) **Edit “Hardwear Configuration”**
    The following setup can be changed in this window.
    - Throttle bore and throttle sensor range.
    - Injector flow rate (feed rate, cc/min).
    - Idle Throttle position(%).
    - Injector reaction period(injector dead time,msec).
    - Dial Controller range.
    - Intake pressure sensor (boost sensor) range.

*Since the item set up on this window is adjusted to the composition parts of this products[set], before shipping, you do not need to change those settings.

(10) **ECU Data Monitor**  p2-27
    You can see the information in ECU using a “data monitor” function. An updating cycle is about 1 time in 1 second.

(11) **Read settings form ECU and save to the file**  p2-7, p2-9, p2-10, p2-26
    A setup read from ECU can be saved at a file. Moreover, a setup saved at the file can also be sent to ECU.
Memo
(c) Start and Exit

Start “SWB”

Please click [Start] > [programs] > [Setting Workbench] > Setting Workbench ,It will start

The 2nd “SWB” can be started when one “SWB” has started. For example, it is possible to edit a map etc., comparing the screen of two “SWB”. However, since “SWB” does not take out warning to saving to the same file in this case, be careful of management of a file.

Exit “SWB”

SWB will be ended when "end" button in the window upper part is clicked, or X buttons at the right end of an upper end are clicked, or "Exit" of a "File" menu is clicked. At this time,since the message which checks saving to the file is displayed when the read data has change, please click “save” or “cancel”.

The 2nd “SWB” can be started when one “SWB” has started. For example, it is possible to edit a map etc., comparing the screen of two “SWB”. However, since “SWB” does not take out warning to saving to the same file in this case, be careful of management of a file.
The flow of the work in the case of changing a setup is explained.

After starting, setting data is empty in SWB. First, you need to read data from ECU or a file. In this time, you cannot choose any items other than "Open file" and "ECU >> SWB"

*(A) We recommend you to save the data read from ECU before editing as much as possible.

Next, you change the item of the purposes, such as basic injection time, compensation, pump setup, etc.

Then, you save data or transmit data to ECU. Keep in mind that change is not reflected in a setup in ECU until it "transmits."

*(B) We recommend you to save data before transmission at a file.

Since ECU reflects change in control immediately after transmission, there is especially no necessity of restart engine.

A changed setup is saved at ECU, when IG switch is cut (when ECU is turned off).

If the present setup is previously read from ECU before reading a setup from a file when changing a setup read from the file and sending to ECU, only a part with change will be transmitted. The function to transmit only a change part is convenient, when changing a setup and arranging it one after another.
(e) Read Settings from ECU

You connect a personal computer with ECU by the attached communication cable first. Since the window of "COM PORT" opens when a "ECU >> PC" button is pushed, please set up a port number and click the "O.K." button.

A mouse icon becomes a sandglass display during reception, and SWB cannot be operated in the meantime. Reception takes about about 10 seconds. When the message of the completion is displayed after reception is completed, please click the "O.K." button.

The port number of a serial port can be checked with "Device Manager" window of your personal computer.

Since SWB displays an error message when the wrong port number is set up, please click a [ECU>>PC] button again after clicking [Tool] > [Option] of a menu bar and clicking the right number of the "COM PORT" and the "O.K." button. After that, please click [ECU>>PC] button again.

![Device Manager Window](image)

Device Manager Window

[start] > [settings] > [control panel] > [system]
Choose [Hardwear] tab, and click [Device Manager] button.
If reception of a setup is completed, it will become a screen display as shown in the following figure.

ID of ECU and date of last update are displayed on a status bar.

*Transmission and reception of data with ECU are possible only at SWB corresponding to the version of each ECU. Be sure to use SWB set up from CD-ROM appended to the product, or SWB upgraded to the correspondence version.
(f) Read Settings from the File

If the "Open" button in the window upper part is clicked, the dialog of “Open File” will appear. Please select a setting file to open and click the button “Open.” The extension of a setting file is .swp. When reading is completed and the message of "reading completed" will be displayed, please click [O.K.] button.

*A setup of hardware is saved at the setting file. The data received and saved from ECU with different ID cannot be transmitted.*
(f') To change the maximum value of R.P.M. display.

In SettingWorkbench, to make the map easy to see, the maximum value of the display R.P.M. axis can be changed.

**How to change display R.P.M. Max.**

Please click “menu” >> “View” >> “Change R.P.M. Axis Max.”. Please input the value to the box and click OK. The maximum value that can be input is 16000RPM. (Even if the display is changed, a R.P.M. maximum value of the MAP setting is not changed.)

The injection map of the maximum value 12500 rpm becomes hard to see in the display up to 16000 rpm. It becomes easy to expect the change to 12500 rpm by the above-mentioned method.

Of course, if the maximum value of MAP is as many as 16000 rpm, it is possible to use it for the R.P.M. that sees easily by adjusting it.

(Even if display maximum RPM is changed, an actual map is not changed.)
(g) Save Settings to the File

If a setup read from the file is changed or data is received, you can save those data at a file. ECU ID and last update of readed setting are displayed on a status bar.

A comment can be added to the file to save. For example, engine specifications, such as displacement volume, a setting place, the feature of a setup, etc. can be written in freely. When you click "File" > "Save As" from a menu bar, SWB displays the dialog box of a comment input. (if you will carry out overwrite, please click "File" > "Save" of a menu bar.)

When this dialog box is displayed and it is going to save a setup read from the file, the comment in the file saved at origin is displayed on the window. In the case of the data read from ECU, it is displayed as "No Comment." Input a comment here freely and click the "O.K." button. Please click "O.K." to save with the comment currently displayed. Please click "Cancel" button, when a comment is unnecessary. In this case, a comment is saved with "No Comment."

If "O.K." or "cancellation" button is clicked in comment dialog box, the dialog box of "Save file" will be displayed. Please save file in arbitrary file names and folders.

You can check comment of current setting at "file comment" in the "Data Property" window, displayed on clicks "edit" > "property" of a menu bar.
(h) Edit “Basic Injection Time” Settings

* In the case of the D-Jetronic version, please read "the throttle angle" as "intake pressure."

How to change a setup of basic injection time is explained in this chapter. Basic injection time can be changed by the following two methods.

(A) The method of changing a value for every point set up by the engine rotation speed axis and throttle angle axis.

(B) The method of multiplying “Gain” to every domain of throttle angle.

(A) “Changing a value for every MAP point”

If the tab of “Basic Map” is clicked, the screen of basic injection time will open. You can change a value in the form of the window lower part. When you click button of “Edit RPM Axis” and “Edit Throttle Axis ”, the point of which you can edit “injection time” moves. Please move a point to which you want to set up. The current point is shown by blue circle. If button is clicked, a point will jump to an axis of end. Moreover, when you delete the axis which became unnecessary or you newly increase an axis between axes, please click + button of each axis window.

The position of an axis can be adjusted with slider. You can input a value directly to , and click "O.K." button. In this case, you need to input a value between neighboring axes.

Injection time settings of points in a plane at the selected R.P.M. axis are displayed on right side graph window. It will be good to set up referring to left side 3D display and right side 2D display.

You can change injection time with the slider , can also put a direct value into box , and push "O.K." button on “Injection Time” window.

* In the case of the D-Jetronic version, please read "the throttle angle" as "intake pressure."
When the point of graph has exceeded the maximum of a vertical axis in the result of editing injection time, please click "View" > "Standard View" of a menu bar. The maximum value of a vertical axis will be adjusted automatically. Moreover, if "View" > "Zoom In" of a menu bar is clicked, graph will be displayed zooming in low rotation speed and low throttle angle. This is convenient when changing an idol domain.

(B) Multiplying “Gain”

When you click the "Set by Gain" button of the "Input Method" window, the window that has many sliders for adjustment displays. Please adjust a window position so that a map display is in sight, as shown in the right figure.

(B-1) How to use multiplier “Gain”

The slider in a "whole Map Gain" window is used when multiply a value to the injection time of all points.
(i) Change Enable/Disable of Each Compensation

You can set these compensation values to “1.0” quickly with each enable/disable property.

An enable/ disable check boxes are in the form of the compensation tab left lower side. The each compensations are effective when check is on in the box. (details are the following.)

Please disable them when you want to adjust only a basic map or when you want to know the effect of the compensation.

The enable / disable property of the dial compensation can be set here.
If you want to use the system without the dial controller, please off the check on the box of the [Dial Control].

<table>
<thead>
<tr>
<th>Check</th>
<th>ON</th>
<th>OFF</th>
</tr>
</thead>
<tbody>
<tr>
<td>Engine Temp.</td>
<td>the compensation value of Warming-Up Compensation is determined by temperature sensor.</td>
<td>the Warming-Up Compensation value is 1.0</td>
</tr>
<tr>
<td>Start Up</td>
<td>the compensation value of Startup Compensation is determined by temperature sensor at engine starting.</td>
<td>the Startupp Compensation value is 1.0</td>
</tr>
<tr>
<td>Asynchronous Injection</td>
<td>Asynchronous injection is executed according to the throttle sensor speed and setting.</td>
<td>Asynchronous injection is not executed.</td>
</tr>
<tr>
<td>Dial Control</td>
<td>the compensation value of Dial Controller is determined by dial position.</td>
<td>the Dial Controller value is 1.0</td>
</tr>
</tbody>
</table>

NOTE:

D-Jetro version [Accelerate Compensation] is added. see page 2–25.
The pressure of fuel is required for fuel injection. The in-line pump is controlled from ECU. To suppress the consumption of the battery, ECU intermittent drives the pump in a low rotational speed according to the amount of a necessary fuel. In a high rotational speed that the flowing quantity of the fuel increases, ECU drives the pump with PWM (pulse width modulation).

ECU judges the interval of intermittent based on the total of the fuel injection time and the injector capacity. Driving time of the pump is judged based on the voltage of the battery. The setting of the PWM drive can set duty rate according to the rotational speed. Each setting can be changed from PC.

ECU is not measuring the pressure of fuel. Please set up the parameter of ECU, looking at the pressure gauge attached to this products(“Fi System set”) so that required pressure may be obtained.

It can be a switch according to the rotational speed as the intermittent drive by the low rotation, and the PWM drive by the high rotation. You can set the switch rotational speed.

When the power supply is turned on, to give the fuel pressure in the system starting, pump is driven several times. The number of drive can be set.

The form of the pump drive setting appears by click menu > [tool] > [pump setting].

[Intermitant drive (Low R.P.M.) and driving number at system starting]

Setting large number. >> The interval of an intermittent drive shortens.

Setting small number >> The interval of an intermittent drive becomes long.

* In the same [Drive Frequency] setting, intermittent time shortens as the setting of [Injector Capacity] increases.
[ PWM drive (High R.P.M.) ]

The setting of duty(%) can be done in the PWM drive in each R.P.M.

Changing point to edit

Add or delete the point

The circle mark indicates selected point to edit.

Changing R.P.M. value of point. Please input value and click [OK] to apply.

Changing duty(%) value of point. Please input value and click [OK] to apply.

You can also change the duty(%) by slider.

[ Intermitannt drive <> PWM drive mode change. ]

When a value that is smaller than 500rpm is set in Change rpm, it becomes PWM drive a whole RPM.

Changing R.P.M. value of mode change. Please input value and click [OK] to apply.
### (k) Edit "Revolution Speed Limiter" & "Indicator" Setting

#### “Revolution Speed Limiter”

The ECU will stop Fuel injection if engine rpm becomes more than [Rev.Limitation] value. You can set it at the form of the compensation tab left lower side.

Please refer to figure for changing the value.

#### “Shift-Up Indicator”

The Information lamp on the dial controller is turned on when it becomes more than [Shift Up Ind.] value. You can use it as a shift-up indicator.

Please refer to figure for changing the value.

**NOTE:** When the lamp displays the error, the lamp doesn’t light even if the rotational speed is becoming more than the set value.
This section explains the method of editing the following compensation values.

Warm-up Compensation
Start up compensation
Start up injection time
Asynchronous injection time
Fuel Cut Control
(Accelerate Compensation for *D-Jetronic only )

There is the form of changing each values at [ Compensation ] tab.

[How to Change]

First of all, please select the compensation value that you want to edit from the combo box. The compensation value is displayed in the graph as follows.
(1) The value of the sensor for the compensation is a horizontal axis.
(2) The correction value is a longitudinal axis.
Please refer to figure for the method of changing each value.
[ Compensations ]

Warm-up Compensation
(Engine Temperature Compensation)

This compensation is compensating the lack of fuel evaporation and increase in volume of air filled in engine when engine has got cold. You can set the value to each temperature points up to 3.5. Usually, 1.0 or more values are set to the temperature of 70 to 80 degrees C or less.

Start up compensation

This is compensation which increases fuel after starting of engine until it carries out stable rotation. At the time of engine starting, a setting value is determined from the table of this compensation setup based on engine temperature. After starting reduces a compensation value at a fixed rate. Compensation is completed when a value is set to 1.0. You can set the value to each temperature points up to 3.5.

Reduction value of compensation is set in the lower side of compensation window.

There is switch in right side of window. When you click an upper switch, a reduction value increases. Thereby, the time to the completion of compensation becomes short. Conversely, if a lower switch is clicked, the time to a compensation end will become long. Graph expresses the compensation end time in display temperature and R.P.M.
**Start up injection time**

This is not a compensation value. It is injection time which will be injected in a period until it becomes a rotation speed stable. It is not based on the angle of throttle, and rotation speed, but fixed injection time is set up for every point of each temperature. Since evaporation of fuel runs short when engine temperature is low, injection time is increased.

![Start up injection time graph](image1)

**Asynchronous injection time**

Asynchronous injection is the function to perform compensation injection, when change of the intake air volume rapidly between the timings of synchronous injection. Asynchronous injection time is set up to the point of the amount of open angle change of throttle.

![Asynchronous injection time graph](image2)

**Fuel Cut Control**

In engine rotation speed over idle speed, fuel injection is stopped at idle throttle position. Usually, it carries out from a rotation speed somewhat higher than idol rotation speed. Since it is easy to carry out a stole when engine has got cold, a higher rotation speed is specified. In a right figure, for example, at the engine temperature of 70 degrees C or more, when a throttle is an idol position in 3500r.p.m or more, fuel injection is stopped. In 23degree C, Injection is not stopped lower than 8000r.p.m.

This functions also as an idol R.P.M. limiter.

![Fuel Cut Control graph](image3)
**Accelerate Compensation** (for *D-Jetronic only)

This function corrects a gap of the air/fuel ratio by the following reasons.

a) Response delay of intake pressure sensor.
b) The difference in the fuel evaporation by the intake pressure at the time of acceleration or a slowdown. (Throttle open or close)

When Throttle changes in the direction it opens, the volume of fuel is increased. Because engine is changing in the direction whose intake air volume increases and the value of a sensor is following behind time. Conversely, fuel is decreased when a throttle changes in the direction which it closes. Because intake air volume is changing in the direction decreasing and the value of a pressure sensor follows later than it. In this compensation, when a throttle changes, a value is set, and a value is increased or decreased gradually. Compensation will be ended if a value is set to 1.0.

You can set up the value to 0 to 5 times to the point of the throttle change speed of arbitrary acceleration or the slowdown direction.

The value to increase, or the value to reduce is set up in a lower window. It sets up with this button. If an upper button is clicked, it will come to return early, and if a lower button is clicked, it will come to return slowly.

It differs from the asynchronous injection which performs compensation injection temporarily that the volume of synchronous injection is increased or decreased between a certain set-up cycles.

"D-Jetronic" is the registered trademark of Bosh AG
**Boost Compensation (for TB version only)**

This function corrects the injection time according to the intake manifold pressure (positive pressure). Only the version for the supercharged model, this function is effective.

* When the pressure sensor is used for the air pressure, it is also possible to use this function for the atmospheric pressure correction.

* The optional pressure sensor is necessary to use this function.
Please transmit data to ECU after editing the setting.

Before transmitting, we will recommend the edited data to be saved.

Please confirm the connection with ECU. Please confirm ECU is turning on.

Please click "PC >> ECU" button. When the setting of ECU is not read to PC before transmitting, "Send All data?" message is displayed. Please click "OK" button.

If the window of "COM PORT" opens, please set up a port number and click the "O.K." button.

Since SWB displays an error message when the wrong port number is set up, please click a [ECU>>PC] button again after clicking [Tool] > [Option] of a menu bar and clicking the right number of the "COM PORT" and the "O.K." button. After that, please click [ECU>>PC] button again.

A mouse icon becomes a sandglass display during transmission, and SWB cannot be operated in the meantime.

When the message of the completion is displayed after transmission is completed, please click the "O.K." button.

When the IG switch is turned off, ECU maintains the power supply from the backup power supply line while writing the setting to EEPROM (One second or less) and ECU is turned off.

**NOTE:** When the edited setting is transmitted after the setting is read from ECU, only the change part is transmitted. The transmission is completed at time that is shorter to transmit all the settings.
Among the control parameters in ECU, the following information can be displayed on the screen of PC by using the communication. Open rate of throttle, temperature of engine, value of dial controller, and rotational speed of engine, voltage of battery, and injection time.

Please connect ECU with the PC with the communication cable.
Next, please operate "download from ECU" referring to the chapter of "Read Settings from ECU". When the reception is completed, please click "Tool" >> "Data Monitor" of the menubar. The data monitor window is displayed. When "Start" button is clicked, it starts displaying.

The raw data of the sensor is displayed in the left, and the converted physical quantity is displayed in the right. An open rate of the throttle is converted into an open area rate of throttle boa. The open rate of the throttle used in the basic injection map is this open area rate.

In throttle open rate and engine temperature, PC converts into a physical numerical value when the engine speed is zero, and displays them by a red character. When the engine starts rotating, the value in which the conversion calculation is done with ECU is displayed in blue.

* Even if the dial controller’s setting is "disabled", the numerical value displays the value of the dial.
* After engine starting, some parameters are displayed in red character.
Other operations of SWB cannot be done while receiving the timer.

A right graph displays the position of referred map. The graph can be cleared with the button of "Graph Clear".

After the "communication" is stopped by "stop" button, the window can be shut with the "Close" button.

* D-Jetro version  
"Aria Percentage" is changed "Manifold Pressure".

### Setting Workbench ver.1.11.08

1. Display "Total Compansation" rate.
2. Display "ECU Error" status.
3. Shortening at monitor cycle  
   Formare version about 0.5 sec.  
   New version 0.2 sec.
4. You can change monitor cycle.  
   [ 0.1 sec to 2 sec ]

---

**Monitor Cycle Change Button**

**Total Compensation Value.**

**E.C.U Error Display.**

---

![Graph Displaying Position](image.png)

![Monitor Cycle Setting](image2.png)
The A/F sensor that can be displayed is as follows.

- NTK: NGK/NTK UEGO sensor
- LM-2: GRID(INNOVATE) LM-2
- LX-2: GRID(INNOVATE) LX-2
- LM-1: GRID(INNOVATE) LM-1
- AF-X: NGK(USA) AF-X

It is necessary to connect the analog data output of each sensor indicator (or amplifier) with the Fi harness.

Data is plotted in a right side graph by a round sign of the color according to the value of the air/fuel ratio.

The graph is displayed by R.P.M. vs. Throttle OpenRate (manifold pressure in case of DJ).

Please push the edit button that exists under the color index when you change the boundary of the classification.

Attention

When the boundary is changed, the plot point displaying it now is cleared.
(3) Configure and sensor adjustment

Before use, it is necessary to do “Hardware Configuration” and “Map Adjustment” after ECU is installed to the vehicle. These settings are usually set when “FC design” ships it. However, the thing that shifts by engine vibration the idle adjusting etc. is expected. This chapter explains these adjusting methods.

The set item.

As a hardware configuration.
(a) Setting of close values and full open value of throttle sensor.
(b) Setting of the Idle throttle threshold.

As an adjustment of the map
(c) Adjustment by capacity of injector and displacement of engine.

(a) Setting of close values and full open value of throttle sensor.

ECU must convert from the voltage of the throttle sensor into an open rate of the throttle and refer to the jet map.
The setting to which open rate the voltage of the sensor hits changes according to the installation position of the sensor and the operation angle of the throttle valve.
It has usually adjusted it in "FC design" before ECU is shipped. However, it is likely to shift the overhaul of the throttle body or caused by loosening of the installation by the vibration under use.
We will explain the method of adjusting this value here.

(i) Read Full Open Value

At first, please operate starting “Data monitor” (refer to “Data Monitor Window” chapter).
Open the throttle to the wide (full open) limit. when click "Start" button, the communication begins.
Afterwards, please read the value of the throttle sensor (value of 0-255).
If the value is 255 ,please loosen the sensor installation screw of the throttle body, and adjust to become a value that is smaller than 254 while seeing the sensor value of Datamonitor.
(ii) Read Full Close Value

In the same way, please read the value at full close position. At this time, please rotate the idol adjustment screw until becoming a position in which not the idol position but the throttle is completely closed. Please read the value at the position in which the throttle is completely closed.

(iii) Set Value to PC

Next, please set the sensor value to ECU, according to the following methods.

Please return to the main window, and click "Tool" >> "Hardware configuration" of the menu. opens. When the message is displayed, click "Continuation" button, please.

"ECU Configuration” window The value is set to the frame of "Throttle body" on the left top of the window. Please input the sensor value of full open throttle to the box of "Sensor value of full open".

When the button of "Manual" in the right of the box, "Sensor value of close" is clicked, the input window opens. Please input the sensor value of full close throttle here, and click the “OK” button. when the message of “Value is incorrect” is displayed, the input value may be wrong, please try again from the step, "the full open value".

The input of “Throttle Diameter” is arbitrary. Please use it as a memo of the setting (Map).

(iv) Transmit to ECU

Please confirm the connection of the communications cable, confirm the power supply of ECU is turning on, and click the “PC>>ECU” button.

The mouse icon becomes an “hourglass” display while transmitting, and, meanwhile, SWB cannot be operated. It takes about ten seconds to transmit.

The message of “Complete” is displayed when the transmission is completed and click the "OK" button, please.

The power supply is turned off. ECU maintains the power supply while writing the setting, and the power supply cuts afterwards.
(b) Setting of the Idle throttle threshold.

When throttle position is lower than [Idle Throttle position], the system cuts the fuel if the rotational speed is more than R.P.M. in [Fuel cut control] setting value. This function is "Fuel stop when decelerating". For this function, it is necessary to judge the idle position.

First of all, please read the value of the throttle sensor at the idle position by using [Data monitor]. Next, please set the value to the input box in [ECU Configuration] window shown in figure. Please input a value that is a little larger than the read value. (about 1% or less.)

Please transmit to PC when the edit is completed.
(Please refer to the previous section.)
(c) Adjustment by capacity of injector and displacement of engine.

The injector capacity is recorded in ECU. An injection setup needs to be adjusted, when the injector capacity of your throttle body differs from this, and when the engine displacement volume of the injection control map currently recorded differs from that of your vehicles. The whole injection map is multiplied by the numerical value which is calculated by the following formulas.

Please refer to "Start up manual" - Specification of your “ECU” map.

<table>
<thead>
<tr>
<th>Injector Capacity cc/min *3</th>
<th>Spec Displacement cc *2</th>
</tr>
</thead>
</table>

Value A = Injector Capacity in “ECU” / Injector Capacity of Your Throttle Body
Value B = Your Engine Displacement / Displacement of “ECU” map spec.
Value (for multiply) = Value A × Value B

How to multiply the whole injection map and the value is explained in the chapter of “Edit Basic Injection Time Settings” - "(B) Multiplying “Gain”" in the manual.

* It is convenient to use the import export function to change to the setting matched to the engine displacement and the capacity of the injector. (see section 3-5.)

* NOTE.

You learn the fuel injection time in the calculation by calculating the following formulas.

Injection Time(WOT) [sec] =
   air charging efficiency [%]/100 * engine displacement [cc] * air density
   / AF ratio / fuel density / ( injector capacity [cc/min] / 60 )

Please refer to 1-4 [ About Basic Control Method ] in this manual.
Export & Import function (About the copy of the map between two ECU)

Because the configuration file contains information on individual hardware, the configuration file cannot be forwarded directly between ECU with a different serial number.
The injection time is not corrected by the difference between injector capacity and the engine displacement even if it copies it directly.
The "export & import" is a function to correct an individual difference.

How to "Export".
(1) Please click “File” >> “Setting export” of the menu of the SWB software. Please input the memo arbitrarily.
(2) Next, please input the engine displacement. The input of this item is indispensable.
(3) Please input the file name on the following screen. Please click “SAVE”.

- The extension of the export file is “.sip”.
The compensation table and Injection time settings, system information (serial number and sensor proofreading value, etc.) are written in a usual configuration file, “.swp”.
The injector capacity, the engine displacement(cc), the injection time settings, and the compensation tablers are written in the export file, “.sip”.
This file enables a setting exchange with other ECU.

- The setting of the pump drive is not included in the export file.

How to “Import”.
(1) First of all, please read the setting from ECU. (Or, read from the file.)
(2) Please click “File” >> “Setting import” of the menu.
(3) Please select the file of extension “.sip” that to import it in the selection screen of the file.
(4) Please confirm the content, and enter the next step. Please click the button of “Another file” when you choose another file. Please click “Cancel” when you discontinue import.
(5) Please click the button of “Adjust” when you want to adjust the jet time automatically.
Please click “Not Adjust” when reading without adjusting it. The file is read when “Not Adjust” is clicked and “Setting import” completes.
(6) When you click “Adjust it”
You can select which to be adjusted in three adjustment injection time. Please click “Adjust” after select them. Please click the “Cancel” button when you discontinue import.
(7) Please input the engine displacement of the engine under use and click “OK”.

- The injection time is adjusted in proportion to the engine displacement(cc).
- The injection time is adjusted in inverse proportion to the injector capacity (cc/min).

(8) "Setting import" is completed.
(B) Appendix

**specifications of ECU**

<table>
<thead>
<tr>
<th>Product Number</th>
<th>FI-00</th>
</tr>
</thead>
<tbody>
<tr>
<td>Target</td>
<td>4Cycle engine, single cylinder 2cycle, RE are also available.</td>
</tr>
<tr>
<td>Rated voltage</td>
<td>12V</td>
</tr>
<tr>
<td>Range of voltage</td>
<td>10~14V</td>
</tr>
<tr>
<td>Range of temperature</td>
<td>0 to 70 degree Celsius</td>
</tr>
<tr>
<td>Current consumption</td>
<td>0.2A (MAX) at 12V</td>
</tr>
<tr>
<td>Max R.P.M.</td>
<td>16000r.p.m.</td>
</tr>
<tr>
<td>Output</td>
<td>1 injector driver</td>
</tr>
<tr>
<td>Input</td>
<td>Throttle sensor, Temperature sensor, Revolustional pulse</td>
</tr>
<tr>
<td>Basic Injection Control</td>
<td>Throttle-Speed method (Alpha - N) or Speed Density method (option)</td>
</tr>
<tr>
<td>Compensations</td>
<td>3 compensations</td>
</tr>
<tr>
<td>Pump Control</td>
<td>Intermittent and PWM drive. (Changing by R.P.M.)</td>
</tr>
<tr>
<td>Setting method</td>
<td>Changing from PC. (The setting software, &quot;Setting Workbench for Windows&quot; is required.)</td>
</tr>
<tr>
<td>Communication Interface</td>
<td>RS232C</td>
</tr>
<tr>
<td>size</td>
<td>(W) × (H) × (L)</td>
</tr>
<tr>
<td>Appended</td>
<td>1 Dial controller, 1 temperature sensor, 1 pulse unit (signal interface unit), 1 CD-ROM for install &quot;Setting Workbench&quot; software, 1 Instruction manual, 1 Communication cable</td>
</tr>
</tbody>
</table>

**NOTE.**

1. Don't install ECU by the exhaust tube (High Temperature)
2. The one injector driver can drive 2 injectors at same timing.
3. The revolution pulse is output from the "signal interface unit".
4. We do not guarantee the following matters. Please acknowledge it.
   i. Problem of this software operation by installing other software.
   ii. Problem of movement of other software by installing this software.
Wiring diagram (alpha-N, Throttle-Speed type)

*Attention
wire color
ex.
white / black :
white wire with black line

* If you use other sensor for the replacement of the signal unit,
please follow the content of an attached document.
Wiring Diagram (D-Jetron ~ Speed Density / alpha-N + Boost Sensor)
Connector Diagram

Fi Harness Coupler, Female

Wire Color
- P : Purple
- Gn : Green
- WB : White / Black
- Blu : Blue
- Blk : Black
- R : Red
- Gy : Gray
- Pnk : Pink
- Br : Brown

※Attention
- Wire Color
- White/Black means
- White Wire with Black Line.

View From This Side

#1 ECU 10P

#2 ECU 8P

#OP1 Pressure Sensor
- O : Jetro or Supercharged Only

#T Temperature

#L Log Switch

#3 Throttle Sensor

#4 Dial Controller

#5 Signal Interface Unit

#6 Injector

#OP2 A/F data input

Please connect signal (LP) and GND (0V, Y) according to A/F sensor manual.

2007/06 ver. 4.4 release
2010/12 ver. 4.6 release

FC design co.,ltd.
2-1-48, Fuchuchou-Honmachi,Aki-gun
Hiroshima,Japan
735-0006
Tel: 81-82-287-0211
Fax: 81-82-287-0212
Mail: info@fc-design.com

Copyright (C) fc-design co.,ltd.